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Chapter 6

Policy

In This Chapter
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Admitted Carrier Identification
Summary of Insurance

Accessing the Policy

There are several ways to access policies once they have been placed in force. Depending on the screen that 
is currently displayed or process currently taking place, use the following to help determine the quickest 
route.

When tracking daily workflow, a policy may be accessed from a Home page. Clicking the Details 

 icon of the policy displays the policy underwriting screen. Accessing the policies from these 
screens is generally done while processing daily workflow. An example of use: Policies have been 
received from the carrier and binders need to be closed. Click HOME > BINDER LOG to check for 
the open binder and access the policy to close the binder.

Locate a client from the Search screen and click on the Details  icon. Click the policy number 
link on the client card file below the sticky note or click POLICIES from the Client menu, then the 

Details  icon beside the policy to display the underwriting screen.

The underwriting screen displays with a blue policy header. The information on this screen and the policy 
info tab is locked down after in forcing a new or future renewal policy and can only be changed through 
servicing. 
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Note: The policy’s Status on the underwriting tab’s header displays as Bound for policies 
placed In Force from marketing when the options Bound and Create Binder are selected. 
For information on working with Binders, see “Binders”, Chapter 8, in this Training 
Manual.

Policy Header Information Definition

Branch The policy’s primary Branch assignment displays.

Policy Type/Primary State

The Policy Type displays as either Monoline or Package. A Monoline policy 
contains one line of business. A Package policy contains more than one line of 
business.  

The Primary State is the State/Province of the Client’s primary location physical 
address unless a different State/Province is selected for this policy. 

Issuing Co The Issuing Co (Carrier) is the insurance company writing the policy.

Billing Co
The Billing Co is the company where payments are sent and received by the 
agency for this policy.

Policy Number
The Policy Number may be Unassigned or TBD until the policy is received. 
Enter the actual policy number when it is known through SERVICING > Edit. For 
information on editing the policy, see “Editing the Policy” later in this Chapter.

Policy Description
The optional Policy Description is used to categorize the policy. The Policy 
Description may be left blank.

Policy Term
The Policy Term dates are the effective and expiration dates of the policy.  The 
Policy Term does not change throughout the life of the policy.

Coverage Term
The Coverage Term dates reflect the effective and expiration dates of coverage 
and change as policy coverage is changed through servicing. The Coverage Term 
expiration date of a Bound policy is the expiration date of the binder term. 

Stage
Nexsure determines the Stage of a policy through the Servicing process.  The 
Policy stage is displayed for in-force policies. 

Mode

Nexsure determines the Mode of a policy if the mode is anything other than New 
or New on Existing. When creating a New policy, the mode may be changed to 
New on Existing and when renewing a policy with a mode of new, the selection 
of new, new on existing or renew may be selected. The modes of a policy are 
New, New on Existing, Renew, and Re-New-Co. 

Status
Nexsure determines the status of In Force and Bound policies.  The policy Status 
will change through the servicing process.

Origination Date
The Origination Date is the first Policy Term Effective Date. The Origination Date 
remains static throughout the life of the policy. 
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Understanding the Policy Summary Screen

After clicking the POLICIES link on the Client menu the policy summary screen is displayed. By default all 
active policies are displayed by expiration date in ascending order, showing only the policy header for the 
group. The default may be changed as needed. See “HOW to Use the POLICIES Summary Search Filter”, 
in this chapter, for details on changing the default. The entire policy is grouped together until the policy 
is cancelled or sent to history. The dark blue policy represents the current version and the gray policy 
represents an older version. The coverage term dates are located on the single iteration of the policy and 
is seen only when the policy group is expanded. This date is important when determining what coverages 
were on the policy during a specific time frame. 

Screen Attributes and Behavior:

The policy header is dynamic and displays updates made to the record such as Policy Description, 
Carrier, Policy Number etc. 

To see only the active policies, select the Always Show Active check box. Selecting this check 
box will expand all policy families to show all active policies (blue) including any pending activity 
(pixilated). The save filter setting (found by clicking the [Show] link) can be used to save the Show 
/ Hide active filter so that users may choose to have their default setting show all active policies.

Selecting the [Expand All] link will expand all policy families to show all policies in the family. 
Selecting [Collapse All] link will return to main policy header only view. The save filter setting 
(found by clicking the [Show] link) can be used to save the [Expand All] link so that users may 
choose to have as their default setting.




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Viewing Policies in the Group

Clicking the Expand/Collapse  toggle button will expand all or collapse policy 
iterations. 

The default expanded view sort is by coverage term effective date in ascending order 
and may not be changed in the show filters, but clicking the headers will re-order on 
the selected column. A white pointer will display the direction of the sort (ascending – 
pointing up and descending – pointing down). Only one column header may be sorted at 
a time.  Selecting a different header will change the sort to the newly selected column. 
When the screen is refreshed by searching or navigating away, the order will return back 
to the default. 

Policy group expand ( ) and collapse ( )within the policy group, display a plus or minus 
sign that enables user to hide duplicate invalid policy iterations for the same coverage 
term. 

Clicking the Expand  button will expand policy family to display all policies.

By default, Expand  button will be displayed, meaning the policy iterations with the 
same coverage effective dates that are no longer viable policies (due to edits or out 
of sequence endorsements for example) will not be displayed.  This is done to make 
it easier to locate and select the most updated version of the policy for the particular 
coverage term when reporting claims, answering questions, etc. The Expand/Collapse 

 button is a toggle button which can be selected again to return back to the prior 
selection. If no additional policies exist in the policy group, the Expand/Collapse  
button won’t be available for selection.


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Clicking the Details  icon on the header will display the policy underwriting screen for the 
most current policy.

Clicking the Assign  icon will display the Assignment List dialog box with the list of people in 
the agency assigned to the policy.

Clicking the Retail Agent  icon will display the Retail Agent record and hovering over the icon 
will display the name of the Retail Agent.

Moving the pointer over the Line of Business, Policy Number, Policy Description and Policy Type 
fields on the policy header will display the information in a larger font for ease of reading. Clicking 
those items in the summary view will open a display box containing the selected information.

The Status is displayed on the policy header.

The Change field is a field also found in history and denotes the action that was taken to finalize 
this iteration of the policy.

The Stage is defined by Nexsure and is located on the single iteration of the policy.

The Mode (New, New on Existing, Renew and Re-New-Co) and will display what mode the policy 
is currently in.

The Annualized $ and Estimated Premium amounts from the policy info screen display are found 
on the policy header. (A = agency bill; D = direct bill)

The Billed Premium populates from the posted invoice and is located on the single iteration of 
the policy. 

The Policy Term will display the effective and expiration dates of the policy and is located on the 
policy header.

The Coverage Term will display the effective date of endorsements and/or expiration dates of 
cancellations and is located on the single iteration of the policy. This term indicates the term 
coverages on the policy are valid.

The Issuing Carrier displayed is the carrier writing the coverage and Billing Carrier displayed is 
the carrier who is billing the policy and is located on the policy header.

The Updated By and Updated Date displays the person who updated the marketing quote along 
with the date it was updated and is located on the single iteration of the policy.
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Context Tools are accessed by right clicking on the Details  icon. 

Active (blue and pixilated policies) display active policy context tool menu (options 
include open, add new opportunity, market existing, market new line of business, print, 
service and summary of insurance).  

History policies on policy screen (displayed in gray) display history policy context tool 
(options include open, add new opportunity, market existing, market new line of 
business, print, rewrite and service).

Note: The Remove  icons are no longer available since policies were actually just placed 
into history and not deleted. Due to the policy grouping concept, the entire group will be 
sent to history and this can now only be done by using the History link on the underwriting 
tab’s Navigation Toolbar or by posting a cancellation. In addition, the Delete icon served 
no purpose on the history screen and has been removed.

Identifying Serviced Polices

Pending /submitted endorsements, audits and edits: 

Policy header displays in blue pixilated background until policy service posted or 
aborted.

Single policy iteration displays in blue pixilated background under the policy header.

Pending cancellations: 

Policy header displays with red text until the cancellation posted or aborted.

Single policy iteration with a pending cancellation displays red text.

Pending claim(s): 

Policy header is outlined in red until the claim is posted or aborted.

Single policy iteration is outlined in red. 

Policy flagged for nonrenewal:

Issuing Carrier name on policy header has red strike through it.

Renewed policy:

Policy header displays with a green Details  icon until the policy group is placed in 
history.

Single policy iteration displays with a green Details  icon until the policy group is 
placed in history.

Policy Expiration Date Passed (Expired):

Policy header displays with a red Details  icon until the status is changed by servicing 
the policy or moving it to history.
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Single policy iteration displays with a red Details  icon until the status changed by 
servicing the policy or moving to history.

Selecting the Details  icon of a policy when the expiration date has past but the 
status has not changed to expired will prompt the user to change the Status to Expired.

Active current policy displays with blue background.

Expiration Date Passed (Expired)

Pending Endorsement

Pending Cancellation

Standard Active Policy

Non Renewal Pending

Policy Renewed

Pending Claim

HOW to Use the POLICIES Summary Search Filter
The POLICIES link on the Client menu will populate based on the default filter settings. The search filter is 
used when searching for specific policies or for applying sort filters to change the display order of search 
results. Click the filter’s [Show] link to display the search filters. Enter specific Search and Sort Filter criteria 
and click the Search button to display policies that meet the current search criteria. 

Note: Security rights may change the default filter to restrict policies displayed on the 
policy summary to one or more Business Types. Business Types are Benefits, Bonds, 
Commercial Lines, Financial Services and Personal Lines. If allowed, Users may override 
the Business Types restriction by clearing the filter’s Business Types criteria to search for 
all policies. Click the Business Type(s) Ellipsis  button to select and search for policies 
by one or more specific Business Types.

The current Search and Sort Filter settings may be saved as a personal default view of Client menu > 
POLICIES by clicking the Filter Settings Save button. The next time Client menu > POLICIES is selected by 
the user, the items returned will be filtered by default to display policies that meet the saved search criteria. 
Exercise caution when saving Search and Sort Filter settings with a date range entered as returned items will 
be restricted to that date range. Clear any date search criteria before clicking Save.




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The user’s saved filter settings will not be altered by subsequent searches for specific policies. The saved 
settings will remain as saved and will not be altered by those future searches. Clicking the Restore button 
located between Search and Clear will return the search filter criteria to the saved personal default settings. 
Use the Restore button if you want to view Client menu > POLICIES by the saved default settings before 
leaving the screen.

When search filters are saved, the Reset button is activated. Reset is used to restore the default filter settings 
to the Nexsure default. Reset removes any previously saved search filter criteria. The next time Client menu 
> POLICIES is selected by the user, the items returned will be filtered by the Nexsure default. Search filters 
that display an inactive Reset button do not have any saved filter settings.

Filter Settings Description

Save
Clicking Save stores the current search criteria as the user’s personal default 
view of Client menu > POLICIES.

Restore
Clicking Restore returns the search results to the saved search criteria after 
performing a search using different search criteria

Reset
Clicking Reset restores Client menu > POLICIES to the Nexsure Default and 
removes any saved search criteria

Note: Search results will be returned by displaying the policy header for any policy headers 
that have matching criteria to the search performed. The Files Per Page setting in the 
show filters will display that number of policy headers (Example: Selecting 10 files per 
page will return 10 policy headers).

Adding a Thank You Letter

The attachment option allows you to attach photographs, documents, e-mail, etc to a client or to a client’s 
policy. Documents, such as a thank you letter, can be created and attached using user defined templates.

WHY a User Defined Template?
User defined templates are created in SETUP under the Document Templates link on the Setup Console. 
These are created to save time at client level. Documents created in setup are saved globally and can be used 
on any client in Nexsure. User defined templates can be added to include merge fields that will populate 
from the client and/or policy information into the document at the time the template is merged at client/
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policy level. After the template has completed the merge process it can then be edited if necessary.

Note: See the Nexsure point person in your agency to add document templates.

HOW to Utilize a User Defined Template
There are two levels of attachments, the Client level and the Policy level. An attachment created at the 
Client level is used to attach general information pertaining to the client. An attachment created at the 
Policy level applies to the selected policy.

Locate the appropriate client through SEARCH and click the POLICIES link on the Client menu. All 
in force policies for the client are displayed in a summary view.

Click the Details  icon of the policy.

Click the attachments tab.

Attachments done at the policy level are displayed.

Note: The defaults configured in the [Show] filters option will determine what is displayed 
in the summary view when clicking the attachment tab.

Click the [Add New] link. There are 2 [Add New] links, one on either side of the attachments 
summary.

The Nexsure Office Integration Add New Attachment pop-up window is displayed.

Click the Create Document with Template option.

Enter the Attachment Name, Document Description and click the Next button.


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The Nexsure Office Integration New Document pop-up window is displayed.

Enter the word “thank” into the Template Name field.

Enter the description and select the Document Type, Category and Business Type from the drop-
down boxes. 

If the Template Name, Description, Document Type, Category and Business Type are not known, 
leave the fields blank and click Search. This will display all document templates that have been 
created.

Note: Entering at least one search field will narrow down the search results.

Templates falling within the search criteria entered are displayed in the Available Templates box.

Click on the appropriate template to highlight it and click the Next button.


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The Policy section is displayed. Select the criteria to default into the document from the drop-
down boxes:

Named Insured

Contact

Location

Assignment

Lines of Business (available only if the document will be incorporating application 
information).

Click the OK button. Click Back to page back or Cancel to abort.

The document will be opened in Microsoft Word or Excel (whichever was specified) and will 
integrate with client and policy information.

After the integration process is complete, edit the document as necessary using Microsoft 
Word or Excel functions. Click the Nexsure Fields button to display the XML Tree for access to 
information in the client record. Expand the XML Tree. Selected field information dragged from 
the XML Tree into the document displays at the cursor’s position in the document. Click the 

Nexsure Fields   button to close the XML Tree.
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When the document has been completed, click the Nexsure Save   button.

The Save Nexsure Document dialog box is displayed.

Select Draft to save the document as incomplete and allow future editing of the 
document.

Select Complete to prevent future alteration or editing of the saved document.

Select Save and Return to Document to save and continue editing the document. The 
Save Nexsure Document dialog box closes.

Select Save As to save a copy of the document to local or network folder outside of 
Nexsure.

Click the OK button to save the document per the selected Draft, Complete, or Save and Return 
to Document option. Clicking the Back button will cancel the save and return to the document. 
Clicking Cancel will abort a new document or abort changes to a previously saved draft 
document.

The Attachment summary view is displayed. Documents saved as a Draft display on the 
attachment summary with a Status of Draft.

Click the attachment Details  icon to open a completed document for viewing or a draft 
document for editing. Follow the previous steps for saving a draft document. Click File > Close a 
completed document after viewing.
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Click the Word  icon to change the attachment name or document description. Click OK to 
save or Cancel to close the pop-up window.

Note: To close document templates after creation or editing, always click the Nexsure Save  

 button to display the Save Nexsure document dialog box. A completed document 
opened for viewing may be closed using the Word File menu.

Editing the Policy

Once a quote is bound or in forced, the information contained in the header and application is locked down. 
An Edit is used to make internal changes or corrections to the bound or in force policy. Edits do not generate 
a policy change request form, as they would not need to be sent to the carrier or client. 

Note: Only one Edit may be pending for a policy at a time.

HOW to Process an Edit
A typical edit may include corrections to typing errors, adding the policy number, etc.

Locate the appropriate client through SEARCH and click the SERVICING link on the Client menu.

Select the Edit option.

The effective date will default to today’s date. Edits do not require an effective date so leave this 
field as is.

The Description and Memo fields on the Servicing screen will default to Process edit. To replace 
text, highlight and type text into the Description field or append text. When tabbing from the 
Description field the Memo field defaults to what was entered in the Description field. The text 
may be changed or appended to in this field as necessary. The Description field can hold up to 95 
characters and the Memo field is not limited to this small amount and is intended to be used to 
fully describe what is being done. While both of these fields are used to create the action, it is the 
Description field that can be seen on the policy summary screen, so make sure to enter a short 
descriptive message that will supply at a quick glance what was done.

All in force policies for the client are displayed in a summary view.


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Select the policy to be edited and click the Generate Edit button.

If any changes have been made to the units at risk associated to selected forms and have not 
been updated on the forms, the affected units at risk are presented. These should be selected to 
ensure that the selected policy record will be updated with the changes and in sync with the units 
at risk. After selecting, click Update Selected to add changes to the record. If none are selected 
the Skip will be active. Clicking Skip will not update the forms with the changes made to the units 
at risk associated to the form.

The policy header is displayed with a light blue diamond background. 

Note: An action with a closed status is created through the Servicing process. Nexsure 
tracks the pending edit for you, but if a personal follow up for the edit is need, the status 
of the action can be changed to open. 

The Stage displays Edit and the Status displays Pending in the header, Nexsure determines both.

Add the policy number in the Policy Number field in the header.

Click the Save Changes link in the navigation toolbar under the header.

The edit can be left in a pending status if other corrections need to be made but the information 
is not readily available.

See the HOW to Post or Abort a Pending Edit section.

Note: No other servicing functions can be added to the policy until the pending edit is 
either posted or aborted. 

Adding, Editing and Removing Assignments

Assignments may be added, modified or removed without editing the policy. However, if other commission 
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defaults are to be applied to the policy info tab, the policy must have a pending or future status. Assignments 
added on the client assignments tab are automatically included on the marketing assignment tab. If the 
assignments need to be updated, removed or new ones added, click the assignment tab on the policy detail 
record.

To add a new assignment, click the [add assignment] link. The Assign Account Management window will 
display.  Select the following from the drop-down boxes:

Assign Account 
Management

Definition

Branch Select the appropriate branch. The branch on the assignment identified as the primary will be 
the branch that populates the form.  If the primary branch is changed after the Policy record is 
created, make sure to update the form with the correct branch information.

Department Select a department from the drop-down box. Departments are added by the System 
Administrator in Setup and only available departments for the selected branch are available.

Unit Select a unit pertaining to the Department, if applicable.  Units are not required. Units are added 
by the System Administrator in Setup and only available if added to the selected department 
in setup.

Responsibility Select the appropriate responsibility.  The responsibility defines the role for the selected name 
for this record. The Responsibilities appearing in the drop-down box are added by the System 
Administrator in Setup, Lookup Management.

Name Select the name of the person responsible for this Client.  The Names appearing in the drop-down 
box are Employees that have been added at Branch level in Setup by the System Administrator.

Primary Check this box to set this Assignment as the primary responsibility for the account. The branch 
on the assignment identified as the primary will be the branch that populates the form.  If the 
primary branch is changed after the Policy record is added, make sure to update the form with 
the correct branch information.

Save Button Click the Save button to save the changes. 

Cancel Button Click the Cancel button to abort the change.

The first assignment entered, when adding a new entity, is designated as the primary assignment and is 
identified by a check mark in the Primary check box on the assignment tab.  A primary assignment cannot 
be deleted; to change or delete a primary assignment another assignment will need to be designated as 
primary. This is done on the assignment tab by clicking the details icon of the assignment that should be 
designated as primary. Place a check in the Primary check box to designate the new primary assignment for 
this record and click the Save button. In the assignment tab summary view the newly appointed primary 
assignment will be displayed with a check mark in the Primary check box.  The old primary assignment will 
now be displayed with an active check box in the Remove column on the right side of the record.

To remove selected assignment(s), click in the check box in the Remove column and to remove all except 
for the primary, place a check in the box to the right of the Remove heading label and click the [remove 
selected] link.
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On the popup window remove the check from the box beside Update Other Commissions on Policy Info if 
it is desired to modify the information on the policy info tab and then click the OK button to complete the 
removal or Cancel to abort.

Attachments Tab

For instructions on adding attachments see the CRM training manual Chapter 17.

Classified Tab

Classified can be used to classify marketing records.  Class Codes and Designations are added by the System 
Administrator in Lookup Management found in SETUP.

Note:  Entering information on the classified tab is not required.

The classified tab displays all code classes, descriptions and designations added for this marketing record in 
a summary view. To add classified information, click the [add new] link on the classified tab.
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From the Code Description drop-down box, make a selection. From the Code Designation drop-down box 
select the appropriate corresponding designation and click the [Save] link. Clicking the [Cancel] link will 
abort the process.

To change the codes, click the Details  icon on the summary screen.

Reselect the codes and click the [Update] link.

To remove, click the Remove  icon on the classified tab summary view and confirm removal by clicking 
the OK button on the confirmation popup.
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HOW to Track Pending Edits from the Home Menu
The HOME > EDITS link serves as a way to keep track of policies with a pending edit. The Home menu is 
accessible by clicking the HOME link on the Utility menu in the upper right hand corner of the screen. The 
HOME > ACTIONS screen will be the first screen displayed. To track pending edits, click the EDITS link on the 
Home menu. The Home menu is the third menu down.

Note: When the edit is either posted or aborted, it will no longer appear on the HOME > 
EDITS link. 

Clicking the EDITS link will display all pending edits that fall within the search filter criteria for the 
Agency.

If the edit is not displayed, click the [Show] filter, change the Search criteria and click the Search 
button to initiate a new search.

Edits displayed on the Home Edits screen will have two Details  icons.

Clicking the first Details  icon will display the card file for the client.

Clicking the second Details  icon will display the underwriting tab for the pending 
edit.

HOW to Track Pending Edits from the Client Menu

Access the appropriate entity through SEARCH.

Click the POLICIES link on the Client menu, all in force policies for the client are displayed in 
a summary view. The pending edit is displayed beneath the policy to which it applies in the 

expanded view. The pending edit will have its own Details  icon.
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In the collapsed view the background is the same as the actual edit to make it easy to see that 
there is a change in process on the policy.

Clicking the Details  icon of the pending edit from the version in the expanded view or the 
collapsed view displays the underwriting tab for the pending edit.

If no policy records display on the policies tab, a dialog box displays giving the following options:

OK: Check for policies on the history tab.

Re-Set: Modify the search filter criteria on the current policies tab.

Cancel: Open the marketing tab.

HOW to Use the Edit Summary Screen
Only one edit may be pending for a policy at a time. A pending edit is displayed in a summary view when 
clicking the EDITS link on the Home menu or the POLICIES link on the Client menu. The expanded summary 
view will give you pertinent information for the edit.


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Clicking the Details  icon will display the underwriting tab for the pending edit.

Clicking the Assign  icon will display the Assignment List pop-up window with the list of 
people in the agency assigned to the policy.

On the policy’s header, holding the cursor over the Line of Business/Policy Number/Policy 
Description/Policy Type fields will display the information in a larger font for ease of reading. 
Clicking those items in the summary view will open a display box containing the selected 
information.

The Stage seen on the single iteration of the policy and Status found on the policy’s header are 
determined by Nexsure and will display Edit and Pending respectively. 

The Mode (New, New on Existing, Renew and Re-New-Co) and will display what mode the policy 
is currently in. 

The Updated By and Updated Date displays the person who updated the marketing quote along 
with the date it was updated and is found on the single iteration of the policy in expanded view.

The Annualized $ and Estimated amounts are found on the policies header while the Billed 
Premium is found on the single iteration of the policy, both billed and annualized are determined 
by Nexsure and display the annualized and billed amounts through posted invoices. The 
estimated premium populates from the policy info screen.

The Policy Term will display the effective and expiration dates of the policy on the policies header.

The Coverage Term will display the effective date of endorsements and/or expiration dates of 
cancellations on the single iteration of the policy.

The Issuing Carrier displayed is the carrier writing the coverage and Billing Carrier displayed is 
the carrier who is billing the policy and both carriers are displayed on the policy’s header as a link.

The edit will need to be posted or aborted to remove it from the summary view.

HOW to Post or Abort a Pending Edit

To post or abort a pending edit:

The pending edit can be accessed from the Edits link on the Home menu or from the Policies link 
on the Client menu.

Click the Edits link on the Home menu. All pending edits, which fall within the search criteria, will 
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appear in a summary view. Each pending edit will have two Details  icons. 

Clicking the second Details  icon displays the underwriting tab of the pending edit. 

If the edit changes have been completed, click the Post Edit link in the navigation toolbar under 
the header to post.

The policy header is displayed in blue and copy of the policy, prior to the edit, is sent to history.

Clicking on the history tab will allow access to a copy of the policy prior to the edit.

If the edit is not needed, click the Abort link in the navigation toolbar under the header, click OK 
to confirm. The edit will be deleted and no record of it kept.

Admitted Carrier Identification

To identify admitted carriers on the policy underwriting screen, a check in the box on the header indicates 
that the carrier on the policy is admitted.
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If the carrier is not admitted, click in the box beside admitted to remove the check from the box. The Save 
Changes link on the Navigation Toolbar becomes active. Click the Save Changes link to save the change. The 
check can be added or removed without the policy being in a pending or future status. On policies that do 
not have a pending status, once the Save Changes link is clicked it is not available to select unless the box 
is clicked again.

Summary of Insurance

The summary of insurance tab at policy underwriting of an In Force policy provides a summary view of policy 
information from the application(s). The summary of insurance (SOI) is available only for In Force policies 
at client level, but at policy level the summary may be accessed for the pending or submitted changes. If 
coverage does not exist, then the field will not show up on the summary of insurance. Although if a limit 
exists in a schedule for one item but not the others, then the blank fields will be displayed in order to show 
the one where coverage does exist. 
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The summary of insurance tab at Client level provides a summary view of all In Force policies for the client if 
there are no restricted policies. If restricted policies are present, only those assigned to the restricted policy 
may access summary of insurance at client level.

To display just one line of business from the client summary of insurance tab, select Line of Business from 
the LOB list and click the Refresh View button. All other LOBs will be removed from the view allowing just 
the one to be viewed.

To jump to a specific line of business in the summary of insurance, click the Line of Business link. If more 
than one policy exist for the line of business, click the  to display the policy numbers. Click the policy 
number of the policy to jump to.

Exclude items from the summary by deselecting the check boxes under Include and then click the Refresh 
View button.  Items that may be included or excluded are as follows:

Coverages - Coverage sections of the policy (defaults to selected).

Premiums - Premium fields on the form and the Premium Summary which populates from the 
policy info screen and is only available at SOI Client level. On the premium summary if taxes and/
or fees exist on any of the policies, the columns showing the taxes and fees will also display.  If no 
policies have taxes or fees, only the premium column will display along with the static columns 
for policy #, coverage and carrier. (Defaults to checked)

Schedules - Schedule sections of the form such as vehicles (defaults to selected)

Expired Policies - Policies with a status of Expired (defaults to unselected)

Deductibles - Deductible fields from the form (defaults to selected)

Rating Info - Rating Information from the form (defaults to unselected)
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Other - Fields selected as SOI only. (No other field attributes apply, such as coverages, rating info, 
deductible or premium) (defaults to selected)

Named Insureds - Check box to display master named insured schedule from client profile. 
Named insured schedule is only available at client level summary of insurance. (defaults to 
unselected)

Note: Check box selections will hold during user’s entire session. Once user logs out, the 
check boxes will be reset to defaults as noted above. These check box options are not 
available via NIC access.

A print link has been added to the beginning of each schedule listing to print just that schedule. The Schedule 
will print as it appears on screen with a title of what the schedule is such as Schedule of Vehicles, Schedule 
of Drivers, etc.

Note: The selection of landscape print option is available from print dialog box. Make sure 
to check printing orientation since this is not controlled by Nexsure.

To expand/collapse the schedules a +/- is available so that when selected the schedule will display or hide 
individually as selected. The default for schedules is in expanded view.

The summary of insurance may be printed and exported to Word or Excel. Make sure to take advantage of 
the Microsoft Word Tools to format the Summary of Insurance.  Whatever is displayed on the screen will be 
exported, so for example if the schedules are collapsed, they will not print or export.

For example after exporting to Microsoft Word, it is easy to change the font by first selecting all text in the 
document. This is done by pressing the Control (Ctrl) key and the letter A on your keyboard. All text will be 
highlighted. To reduce the font size, press the Ctrl + Shift keys and the letter P on your keyboard to bring up 
the font selection box. If there are some wide schedules in the document try a small font size such as 8. 
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Experiment by changing the font until the desired result is returned. Next, try changing the orientation. Click 
the Page Layout tab, select Orientation and choose Landscape.

Preview the document prior to printing by selecting Print Preview.

Previewing the document provides the opportunity to see what the paper version looks like. The schedule 
headings will carry over to the next screen when the schedule crosses multiple pages and a page break will 
exist between each line of business to provide a professional look.
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If desired, you may save the exported document locally and then attach to the client’s file. For attaching 
documents, see “Attachments”, in Chapter 17 of this manual.

Note: For downloaded policies, the overflow pages will be included in the summary of 
insurance display.

The summary of insurance disclaimer may be customized for client types of commercial and personal 
separately in SETUP. For instructions, see “Color Schemes and Blank Forms”, in Chapter 5, Admin Training 
Manual.

Where to Locate Fields Mapped to the Summary of Insurance

To see what fields are mapped to the summary of insurance, locate the policy and access the underwriting 

screen. (From Client Policies, click the policy Details  icon) 
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On the underwriting tab, click the ACORD form number in the middle part of the screen to display the 
Dataflow screen.

Click the arrow on the right to open up the summary of insurance portion of the Dataflow screen.

Scroll to see what fields are flagged. Selected fields are included on the Summary of Insurance as follows:

SOI = Appear on the Summary of Insurance.

RTG = Appear on the Summary of Insurance if the Rating Info box is checked on the Summary of 
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Insurance at Client or Policy level.

CVG = Appear on the Summary of Insurance if the Coverages box is checked on the Summary of 
Insurance at Client or Policy level.

DED = Appear on the Summary of Insurance if the Deductible box is checked on the Summary of 
Insurance at Client or Policy level.

PREM = Appear on the Summary of Insurance if the Premium box is checked on the Summary of 
Insurance at Client or Policy level.
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The Summary of Insurance may be printed or exported to Microsoft Word or Excel. Nexsure Instant 
Collaborator, NIC, grants temporary access to clients allowing them to view and print their Summary of 
Insurance document.

To grant temporary access to a client contact, click the NIC link. The Security - Create Temporary User dialog 
box displays.

Select the contact to be given temporary access.

Select the number of days when the login is to expire.

Edit the message with personal instructions for the contact.

Click [Close] to abort or [Send] to send the access invitation to the contact.

When the “Successfully created temporary user login” message displays, close the dialog box.

The contact will receive an email invitation with a login link. 
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Clicking the link displays their Summary of Insurance with a Print link and a Logout link. 

You will receive a Temporary user status update email notification with the date and time the Contact 
completed their task. Temporary access terminates the earlier of the Contact logging out or when the 
temporary login was set to expire.
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